GREAT TIPS TO MAKE THE MOST
OF YOUR BROWSER
Tips are for Internet Explorer 5 unless Netscape is stated. Article was written for Windows
95/98/ME. Some tips may be similar in Macs
A is for addresses and automatic features
1.

To delete Internet addresses from the drop down bar on a home page: Go into My
Computer/-Control Panel/Internet Options and clear the "History'.

2.

To stop an Internet address from being automatically completed when you enter the first
few letters: Click start - settings - control panel - Internet options. Click on the advanced
tab and scroll down to the Use online Auto Complete in Internet Explorer' setting and uncheck the box.

3.

To try to prevent your computer automatically trying to dial the Internet on start-up:
Check to see whether you have any Internet shortcuts on your desktop or in your start up
folder, then remove them. To find out, highlight all icons on the desktop, right click on
properties and see if any have an URL attached. To check the start up folder, click
start/settings/task bar/advanced/programs/startup.

B is for Bookmarks
4.

The bookmark feature of a browser lets you store and organise the addresses of Web sites
you want to visit again (Internet Explorer calls Bookmarks "Favorites.'). Whether you use
Netscape or Explorer, a quick way to bookmark is to hold down the Ctrl key on your
keyboard and then press the "D' key. Your browsers will automatically bookmark the
Web page you are on.

C is for cookies and cache
5.

Cookies allow advertisers to gather information about Web visitors. Unfortunately, any
type of software can be introduced to your computer through the use of cookies,
including viruses. This makes for a high-risk security problem for your PC.
To turn off cookies:
 In Explorer 5 Select "Tools Internet Options...' from the main menu. Change to
the "Security' tab. Click "Custom Level...'. Scroll down to the "Cookies' section.


To enable: Set "Allow cookies that are stored on your computer' to "Enable'. Set
"Allow
per-session cookies' to Enable'.



To disable: Set "Allow cookies that are stored on your computer' to "Disable'. Set
"Allow
per-session cookies' to "Disable'. To get a prompt: Set "Allow
cookies that are stored on
your computer' to "Prompt'. Set "Allow per-session
cookies' to "Prompt'. Click "OK'.
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6.



In Netscape Communicator 4 Select "Edit - Preferences...' from the main menu.
Select "Advanced' To enable: Select "Accept all cookies' or "Accept only cookies
that get sent back to the originating server'



To disable: Select "Disable cookie' To get a prompt: Check "Warn me before
accepting a cookie' and select "Accept all cookies' or "Accept only cookies that
get sent back to the originating server' Click "OK'

Clear your browser cache frequently. If Web pages are loading and then seem to "hang'
and the base bar says "Document Done click stop and reload', it's time to clear your
cache.
For Netscape Communicator 4 Select "Edit Preferences...' from the main menu. Change
to the "Advanced | Cache' section. Click on "Clear Memory Cache' and "Clear Disk
Cache' buttons to clear memory and disk cache.
For Explorer 5 Select "Tools Internet Options...' from the main menu. Change to the
"General' tab. Click on "Delete Files' button.

D is for disconnect and download
To avoid constantly being regularly disconnected from the Net, remember the following points
about your phone line:
7.

Make sure that you DO NOT have "call waiting' turned on when you are on the Internet.
Otherwise, your Internet connection will be cut off when the line receives an incoming
call.

8.

If your modem shares a line with a telephone, fax or answering machine, try
disconnecting these devices before you connect. Also ensure that no one picks up another
phone while you are online, as this can also disconnect you from the Internet.

9.

Check for and clear any message from your line prior to connecting to the Net, or
disconnect the messaging service.

10.

Avoid using phone extension cords. If you have to use an extension cord, buy a good
quality one no longer than is absolutely necessary.

11.

If you are using Windows 95 and 98 Dial-Up Networking, you can also try this setting to
avoid being disconnected: Double click your "My Computer' icon. Double click your
"Dial-Up Networking' icon. Click your RIGHT mouse button on your connection icon.
Click "Properties'. Click the "Configure' button. Click the "Connection' tab. Click the
"Advanced' button. The initialization string goes into the "Extra settings' box. (s10=50)

12.

Download and browse at the same time to prevent your Internet connection from timing
out. Sometimes when you're waiting for a Web site to respond or for a file to download,
you might find that Windows 95 disconnects you. An error message states that you've
reached your connection "time-out'. Windows' Dial-Up Networking utility has
disconnected your computer because you have left it unattended for an extended period
of time. To increase the time-out value, open the Internet Options dialog box (issue the
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Internet Options... command on the View menu), click the Connection tab, and click the
Settings button to open the Dial-Up Settings dialog box. You'll see the Disconnect If Idle
For check box followed by a spin control field. Increase the value in the spin control field
to 10 minutes or higher. This should allow enough time to prevent the disconnection
while you're downloading files or accessing busy sites.
13.

If your modem disconnects during a download and the download window stays open,
keep the window open, reconnect to the Internet and start downloading the file again.
Often, Internet Explorer will resume the download from where it left off.

14.

To speed up downloads, always use FTP (rather than HTTP) software for the download.
Most FTP clients can be configured to repeatedly dial busy download sites and maintain
a constant connection. FTP programs can also be set to reconnect and continue downloading if a connection is broken.

E is for Extensions
15.

If you have downloaded a file from the Internet that can't be opened, look at the extension
of the file name to discover which program you need to run it. For example a file that
ends in .exe is a program. A file that ends in .txt is a text file and can be opened with a
word processing program or WordPad. Here are some others: .ppt Microsoft powerpoint
(slide show) file, .doc Microsoft Word (word pro-cessing) document, .xls Microsoft
Excel (spread-sheet) file, .jpeg and .bmp Graphic (picture) file, .gif and .tif Graphic file,
.avi and .mpeg Video file

F is for Favourites
16.

Get to a favourite site almost instantly with the Windows 95's Run program. From the
Start button, select run and type the complete URL for a favorite site including the http://.
Windows will then launch your default Web browser and go straight to the site.

17.

Favourites is a function of the IE browser that lets you store and organise your most
visited Web sites. To set a site as a favourite, go to the page you want to add to your
Favorites list. On the Favorites menu, click Add to Favorites. Type a new name for the
page if you want to.

18.

To transfer Internet Explorer Favourites between computers: Open Internet Explorer,
click File/Import Export. Select Export Favorites and save them to a disk. Then put the
disk in the new computer and click Import Favorites under the same menu.

19.

To sort favourites alphabetically, click the Favorites menu on the toolbar (not the
Favorites button). Right-click a favourite, then choose Sort By Name. You should be all
set, though you'll need to take this step periodically to keep things in alphabetical order.

G is for Graphics
21.

To cut down on unnecessary graphics and speed up your browsing, click the Advanced
tab in the Internet Properties (or Internet Options) dialog box. Scroll to the Multimedia
section of the Advanced tab display window. Click each multimedia check box (for
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example, Show Pictures, Play Videos, Play Sounds, and Smart Image Dithering) to
remove all check marks.
H is for history
22.

To find out which Internet sites the last user of your computer has accessed: Just click on
the HISTORY button on the top of the screen. If any sites are available, they will be
displayed down the left hand side of the screen. You then expand each day/week to see
what was visited. You can set up this history period manually by going to Control Panel
Internet Options History.

23.

To clear the history, Go into My computer/Control panel/Internet options and select
"history.'

I is for images
24.

You can save an image from a Web page as a graphics file by positioning the mouse over
the image and right-clicking (Windows) or holding down the mouse button (Mac) and
selecting Save Image As. Select where you want the image to be stored on your computer
and click Save.

J is for Jerky
25.

If you notice Web pages loading slowly or in "jerks,' select Internet options from the
Tools menu on the browser. From the Advanced tab (listed under Browsing options)
select Smooth Scrolling. Click OK.

K is for Kill animated gifs
26.

Animated gifs are the moving pictures that appear on some Web sites. They can slow
down your browsing. To disable them, select Tools/Internet options and click the
Advanced tab. Scroll down to the multimedia section, deselect the Play Animations
option and click OK.

L is for language alternatives
27.

To select a different language for your browser click Start/ -Settings/Control
Panel/Regional settings. Then select the language you want from the drop down box and
restart Windows.

M is for modem speed and multiple windows
28.

Check your modem speed and get the best connection rate. Set the DTE rate as high as
possible. Usually 115,200 bps on recent PCs. 230,400 bps will likely become the norm
on newer PCs. If nothing happens when you 'log on' change the setting to a slower rate
and try again.

29.

Modem Line Rate Force your modem to connect at a lower speed (2400 or 4800 bps less)
if it retrains (pauses transmission and re-negotiates the connection) often or your calls
break down frequently. A stable connection at a lower speed can often give more data
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30.

throughput than an unstable connection. Check your modem's handbook to find out how
to set the maximum line rate. Windows 95 and 98 Dial-Up Networking Double click your
"My Computer' icon. Double click your "Dial-Up Networking' icon. Click your RIGHT
mouse button on your connection icon. Click "Properties'. Click the "Configure' button.
Click the "Connection' tab. Click the "Advanced' button. The initialization string goes
into the "Extra settings' box. (s10=50)
Cut Searching and Browsing Time by having multiple browser windows open at the same
time. You can even drag links from one browser window to the other to load a page while
you are reading.

N is for Netscape Navigator browser
31.

Sometimes the Web can be s-o-o-o slow. You can speed browsing up dramatically by
turning off graphics in Web pages. That way, only the text is shown and you save the
download time getting all the pictures. While using Navigator select Edit, then
Preferences. Click Advanced and uncheck the box next to Automatically Load Images.
Note that while you turned off graphics as above, you can still view a graphic or picture.
Just click on its icon and Navigator will fetch the image for you.

32.

Send a Web page you are viewing with NN to someone else via email. Drag the
bookmark icon (located to the left of the location field) into the attachments list tab of
your email message. Or select the "send page' option from the NN File menu and send a
copy of the open page via email.

33.

To see a history of sites you have recently visited, press Ctrl-H. You can sort the list by
name or location.

34.

Click on the My Netscape button to personalise the browser to suit your interests.

35.

Set a bookmark. On the Netscape Navigator Toolbar menu, click Bookmark. A menu
appears. Select Add Bookmark on the menu. You can also click on File Bookmark and
put in your designated folder.

O is for Open
36.

To open a new Navigator window, click Ctrl-N (Windows) or Command-N (Mac)

P is for Password removal
37.

To remove your password so that you can connect directly to the Internet or Outlook
express, Click Start Settings Control Panel Internet Options. Click the 'Connections' Tab,
then highlight your dial-up connection and click the settings button. Set up your name
and password, click OK, now check the box 'Always dial my default connection'. Now
when you click on IE it will bring up your connection box. You now need to check the
box to bypass the security check and it will auto log in every time you hit IE.

Q is for line quality
38.

The quality of your phone line is the responsibility of your telephone company and they
are obliged to ensure that your line is of an acceptable Internet standard. A simple way to
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check the quality of your phone line is to pick up a fresh connection and dial a 1. There
should be no noise or crackling on the line.
R is for repair
39.

If you have trouble every time Internet Explorer runs up, note that IE has a self-repair
function. To find it select Start/Settings/Control Panel. Double click Add/Remove
programs and select Microsoft Internet Explorer 5 and Internet Tools. Click the
Add/remove button. From the options presented to you, select Repair Internet Explorer.
After the repair process is complete, restart Windows.

S is for shortcuts and searches
40.

You can use almost All the popular search engines on the Web to search for a phrase IF
you place all the search key words in quotes. For instance, a search for the words site
promotion will bring results for the individual words. If you submit the words "site
promotion' you'll get results on the entire phrase.

41. I

nternet Explorer makes it easy to send Web pages using Outlook Express. Follow these
steps while visiting a Web site you wish to e-mail to someone:
 From the File menu, choose Send
 Choose either Page By Email or Link By Email. Both operations will launch the
Compose Message dialog box in Outlook Express. Page By Email places the Web
page contents as your message. There is room at the top of the message area for a
one-line message from you. Link By Email places the URL for the page in your
message area and a shortcut to the Web page as an attachment.

42.

To set up a desktop shortcut that will automatically dial your ISP and connect to a
favourite Web site when you click on it, put your mouse on the desktop and right click.
Select New, then Shortcut. In the Action window, type in the URL of the site you want to
regularly connect to.

43.

To search on the Internet, enter the Web address of a search engine into the top browser
window. Here are some good search addresses: www.google.com, www.yahoo.com,
www.altavista.com, www.excite.com. When the search site loads, find the blank search
window on the site and type in a few key words based on what you are looking for. The
site will return to you a list of sites. You can also type "search' and a key word or phrase
in the URL window at the top of the browser. Or just click on the Search button at the top
of the browser window.

T is for Toolbar buttons
44.

You can add or remove buttons from the Internet Explorer toolbar. Right-click the
toolbar and click Customise. This will display all the buttons. Add the buttons you want
to the toolbar by selecting the button you want, hitting Add and click Reset.

U is for URL
45.

A URL is another name for a Web address, so www.netguide.co.nz is both a Web address
and a URL. To type in a URL, go to the top window of your browser and if an address is
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already there, highlight it and press the delete key. In the blank window type the URL of
the web site you want to access.
V is for video
46.

To see video clips that are available for viewing on a Web site, double click on the link to
the video. If it doesn't play, you probably need specific media player software like the
free player available from www.realplayer.com

W is for Web settings button
47.

To restore IE's default settings (and undo any customisation you may have attempted),
select Internet Options from the tools menu. Click the Programs tab and the Reset Web
Settings button.

X is for eXtra RAM
48.

Check how much memory you have in your computer a minimum of 16 megabytes is
recommended for browsing. To check, click Start/Settings/Control Panel/System. Your
processor type (eg Pentium) and current Ram amount will be displayed.

Y is for Your own home page
49.

To choose which home page loads every time you load your browser, go to the page you
want to appear when you first start Internet Explorer. On the Tools menu, click Internet
Options. Click the General tab. In the Home page area, click Use Current.

Z is for overly Zealous
50.

You can "tweak' your browser to personalise it or change its decor, but you can seriously
affect the performance of your browser if you change settings without knowing what you
are doing. Always double-check your actions against printed or online advice from
reliable IE or Netscape sources.

This information was taken from the NetGuide website at:
www.netguide.com.au/useful_stuff/tutorials

